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Setting Up a Slide Show 
 
Before delivering a presentation in front of an 

audience, there are several things you should consider. 
 

Specify the show type 
 
Are you going to be delivering your presentation in front 

of a live audience or unattended at a kiosk? This section 

will help you decide. 
 
 Click the Slide Show tab on the Ribbon and click 

the Set Up Slide Show button in the Set Up group. 
 

The Set Up Show dialog box appears. Under Show 

type, you have several options from which to choose: 
 

Presented by a speaker: This is the typical full-

screen slide show. You can advance the slides 

and animations manually, or you can set 

automatic timings. 
 

Browsed by an individual: Runs the slide 

show in a standard window, with custom menus 

and commands for the viewer to use. 
 

Browsed at a kiosk: Delivers the slide show as a 

self-running show that restarts at the end of the 

presentation. The viewer can click hyperlinks and 

action buttons but cannot modify the presentation. 

 
 Select the desired option and click OK to save your 

changes. 
 

Specify show options 
 
Do you want your slide show to start over automatically 

each time it finishes, or do you want to run it without any 

of the recorded narration? This section shows you how. 
 
 Click the Slide Show tab on the Ribbon and click 

the Set Up Slide Show button in the Set Up group. 
 

The Set Up Show dialog box appears. Under 

Show options, you have several options from 

which to choose: 
 

Loop continuously until ‘Esc’: Select this 

option if you are leaving the show unattended and 

want it to continuously repeat. 
 

Show without narration: If you recorded 

narration but don’t want to use it, select 

this option. 
 

Show without animation: Select this option to 

disable animations. This might be necessary for 

presentations being viewed on slower computers. 

 

 
 Exercise  
 Exercise File: Employee Orientation12-1.pptx 

 
 Exercise: Open the Set Up Show dialog box and specify 

that the presentation be presented by a speaker and that the 

slides in the presentation will be advanced manually.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 12-1: The Set Up Show dialog box.  
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 Select the desired option and click OK to save your 

changes. 
 

Specify which slides to include 
 
Do you want to include all slides in a slide show or only 

select ones? This section shows you how. 

 

 Click the Slide Show tab on the Ribbon and click 

the Set Up Slide Show button in the Set Up group. 
 

The Set Up Show dialog box appears. Under 

Show slides, you have several options from which 

to choose: 
 

All: Select this option to include all slides in the 

presentation (except for slides you’ve hidden). 
 

From: Select this option to include a range 

of slides that you specify. 
 

Custom show: Select this option to pick and 

choose any number or range of slides that 

you wish. 
 
 Select the desired option and click OK to save your 

changes. 
 

Specify how to advance slides 
 
Do you want to advance through the slides in a 

presentation manually or let PowerPoint do it for you? 

This section will help you decide. 

 
 Click the Slide Show tab on the Ribbon and click 

the Set Up Slide Show button in the Set Up group. 
 

The Set Up Show dialog box appears. Under 

Advance slides, you have two options from which to 

choose: 
 

Manually: Selecting this option requires you 

to click the mouse or use the keyboard to 

advance slides. 
 

Using timings, if present: Select this option to 

move slides forward automatically based on 

the timings you save when you rehearse. 
 
 Select the desired option and click OK to save your 

changes. 
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Rehearsing Slide Show 

Timings 
 
When you deliver your presentation in front of an 

audience, you want to make sure that each slide is 

displayed for an adequate amount of time. Use 

PowerPoint’s Rehearse Timings feature to specify the 

amount of time between slides when you are rehearsing 

your presentation. 
 
 Click the Slide Show tab on the Ribbon and click the 

Rehearse Timings button in the Set Up group. 
 

The presentation opens in Slide Show view, and 

the Recording toolbar appears. 
 
 Navigate through the presentation, leaving each slide 

displayed for the approximate length of time that you 

want it to be displayed during your presentation. 
 

Tip: Keep in mind that PowerPoint is recording 

your every move, so don’t rush through your 

slides unless you want your viewers to be 

rushed, too.   
Tip: If you mess up or want to restart the 

timing on a slide, click the Repeat button on 

the Recording toolbar.   
When you’re finished, a dialog box appears asking 

whether or not you want to save your timings. 

 
 Click Yes to save your timings or click No to discard 

them. 
 

If you chose to save your timings, your slides will 

automatically advance using those timings the next 

time you run the slide show. 
 

Tips 
 
 If you decide you want to run your presentation 

manually without timings, click the Slide Show 

tab on the Ribbon and click the Set Up Slide Show 

button in the Set Up group. Select Manually under 

Advance slides and click OK.


 To redo your timings, simply run the Rehearse 

Timings feature again.

 

 
 Exercise  
 Exercise File: Employee Orientation12-2.pptx 

 
 Exercise: Begin rehearsing the presentation. 

 
Navigate through the presentation, leaving approximately 5 

seconds for each slide. 
 

In the dialog box that appears, choose NOT to save your 

slide timings. 
 

Switch back to Normal view. 
 
 

 
Slide Time  
Total time elapsed 
for the current slide.  

Next button    Total Time 
Advance to the  

 
 Total time elapsed   

next slide.     
 for the entire 

  

      presentation.  
 

Pause button Repeat button  
Stop the timer Reset the timer to zero 
temporarily. Click so you can rehearse 

again to resume the current slide again.  
rehearsal. 

 
Figure 12-2: The Recording toolbar. 

 
 
 

 
Rehearse Timings button  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 12-3: Saved timings will appear underneath each 

slide in Slide Sorter view.  
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Adding Comments to a Slide 
 
Adding a comment to a slide is like sticking a Post-It 

note to it. You can use comments to add suggestions, 

notes, or reminders to a slide. 

 

Insert a comment 
 

 Navigate to the slide to which you want to add a 

comment. 
 
 If you want to attach the comment to a particular 

object on the slide (placeholder, image, etc.), click 

the object to select it. 
 
 Click the Review tab on the Ribbon and click the 

New Comment button in the Comments group. 

A new comment box appears. 

 
 Type your comment. When you’re finished, click 

anywhere outside the comment box to deselect it. 
 

Edit a comment 
 
You can easily make changes to a comment simply 

by typing in any comment box. 

 
Click in the comment box and edit the text as needed. 

 

Delete a comment 
 
Delete a comment when it is no longer needed. 

 

Select the comment box and click the Delete 

Comment button in the Comments group of the 

Review tab on the Ribbon. 
 

Other Ways to Delete a Comment: Right-

click the comment box and select Delete 

Comment from the contextual menu.  
 

Hide or show comments 
 
If comments are distracting, you can temporarily hide 

them from view. 

 
Click the Review tab on the Ribbon and click the 

Show Markup button in the Comments group. 
 

Tips 
 
 Comments do not appear in Slide Show view or Slide 

Sorter view.


 You can add more than one comment to text, 

an object, or a slide in a presentation.

 

 
 Exercise  
 Exercise File: Employee Orientation12-3.pptx 

 
 Exercise: Navigate to Slide 8 and insert the following 

comment:  
Make sure to reiterate the topics covered and remind 

group to submit paperwork to HR as soon as possible. 
 

Hide this comment when you’re finished. 
 
 
 
 
 
 
 

Jump to next 
Insert a new Delete a comment  
comment comment   

Jump to 
Hide/show Edit a previous  
comments comment comment  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 12-4: Use the commands in the Comments group to 

insert, edit, and delete comments in a presentation. 
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Hiding a Slide 
 
If you don’t want a slide to be included in the final 

slide show, you can hide it from your audience. 
 
 Navigate to the slide you want to hide. 

 
 Click the Slide Show tab on the Ribbon and click the 

Hide Slide button in the Set Up group. 
 

The slide number is crossed out, indicating that 

the slide is hidden. 
 

Other Ways to Hide/Unhide a Slide:  
Click the Slides tab in the Outline pane, right-

click the slide that you want to hide or unhide, 

and select Hide Slide from the contextual menu. 
 

Tips 
 
 To unhide a slide, repeat the steps listed above.


 If you are in Slide Show view and want to display a 

hidden slide, right-click the current slide, select Go 

to Slide from the contextual menu, and click the slide 

that you want to unhide.

 

 
 Exercise  
 Exercise File: Employee Orientation12-4.pptx 
 
 Exercise: Hide Slide 8 so that it will not appear during the 

slide show. Then, unhide it. 

 
 
 

 
Hide Slide button  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 12-5: Slides that are hidden have their slide  
number crossed out.  
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Recording a Presentation 
 
You can make sure that your audience hears what you 

have to say by adding voice narration to your slides. 
 

Tips 
 
 You must have a microphone attached to your 

computer in order to record narration.
 

Record a slide show 
 

 Open the presentation you want to record, click the 

Slide Show tab on the Ribbon, and click the Record 

Slide Show button in the Set Up group. 
 

The Record Slide Show dialog box appears. 

Here, you can select what you want to record. 
 

Slide and animation timings: Records the amount 

of time you spend on each slide as well as the timing 

set for the animations in the slide show. 
 

Narrations and laser pointer: Records your 

voiceover as you navigate through the slide 

as well as your use of the mouse in laser 

pointer mode. 
 
 Select what you want to record and click Start 

Recording. 
 

The presentation opens in Slide Show view, and 

the Recording toolbar appears. 
 
 Navigate through the presentation, leaving each slide 

displayed for the approximate length of time that you 

want it to be displayed during your presentation. 
 

 Tip: Keep in mind that PowerPoint is recording 

your every move, so don’t rush through your 

slides unless you want your viewers to be 

rushed, too. 
 

Tip: If you mess up or want to restart the 

timing on a slide, click the Repeat button on 

the Recording toolbar.   
When you’re done, the saved timings will appear 

underneath each slide in Slide Sorter view. The 

narration for each slide will appear as a sound icon 

on the lower right corner of the slide. 
 

The next time you run the slide show your slides will 

automatically advance using the recorded timings and 

narration (if applicable). 

 

 
 Exercise  
 Exercise File: Employee Orientation12-5.pptx 

 
 Exercise: Understand the process of recording narration 

and timing for a presentation.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 12-6: Saved timings will appear underneath each 

slide in Slide Sorter view. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 12-7: The narration appears as a sound icon in 

the lower right corner of each slide. 
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Clear slide timings 
 
If you’re unhappy with the slide timings for your slide 

show, you can clear the timing for one or all slides. 

 
 Click the Slide Show tab on the Ribbon and click 

the Record Slide Show button list arrow in the Set 

Up group. 
 

A list appears. 

 
 Select Clear from the list and select either Clear 

Timing on Current Slide or Clear Timing on 

All Slides. 
 

The timings are cleared. 

 

Clear slide narration 
 
As with slide timings, can clear slide narration if you’re 

dissatisfied with it. 

 
 Click the Slide Show tab on the Ribbon and click 

the Record Slide Show button list arrow in the Set 

Up group. 
 

A list appears. 

 
 Select Clear from the list and select Clear 

Narration on Current Slide or Clear Narration 

on All Slides. 
 

The narration is cleared.  
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Marking a Presentation 

as Final 
 
Before you share a copy of your presentation with other 

people, you can use the Mark as Final command to set 

the presentation as “read-only,” preventing reviewers or 

readers from making any inadvertent changes. 
 

Mark a presentation as final 
 

 Click the File tab on the Ribbon. 
 

The Info tab in Backstage view appears. 

 
 Click the Protect Presentation button and select 

Mark as Final. 
 

The Microsoft PowerPoint dialog box appears 

notifying you that the presentation will be marked 

as final and then saved. 
 
 Click OK. 
 

The Microsoft PowerPoint dialog box appears 

describing what happens when the document is 

marked as final. 
 
 Click OK. 
 

The presentation is marked as final. The Permissions 

section of the Info tab moves to the top of the screen. 
 

Trap: The Mark as Final command is not 

supported in the 2003 and earlier versions of 

PowerPoint. If your presentation is opened in 

an earlier version, your reviewers and readers 

can make changes.  
 

Remove Mark as Final status 
 
You can remove Mark as Final status the same way 

you applied it. 
 
 Click the File tab on the Ribbon. 
 

The file commands and Backstage view appears. 

 
 Click the Protect Presentation button and select 

Mark as Final. 
 

Mark as Final status is removed. 
 

Tips 
 
 The Mark as Final command is not a security feature 

and should not be used as one. Mark as Final status 

can be removed at any time by anyone who receives 

a copy of the presentation.







     Reference: 


 

 
 Exercise  
 Exercise File: Employee Orientation12-6.pptx 

 
 Exercise: Mark the presentation as final.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 12-8: Mark your presentation as final in Backstage 

view.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 12-9: When a presentation is marked as final, the 

Info bar notifies the user that the presentation is marked 

as final and the editing commands on the Ribbon are 

disabled.  


